uMark Introduction
What is uMark?
uMark is bulk image watermarking software. It allows photographers to add visible watermarks to their digital images in a snap. You can use uMark to watermark hundreds of images at one go with your name, copyright information or logo. uMark also facilitates bulk resizing and renaming of images.
What’s new in version 3
 Unlimited watermarks can be added
 EXIF properties can be added as watermarks
 Supports multiple languages

 Faster processing, better memory utilization
 Built using latest Microsoft .Net Framework 3.5 and Windows Presentation Foundation
System Requirements
 Windows XP or later
 Microsoft .Net Framework 3.5
Watermarking Process
The watermarking process consists of three steps

1. Adding images to watermark 

2. Creating watermarks 

3. Specifyig output options and starting the watermark process 

Main Program Window

The main program window of uMark is mainly divided in two parts. The images and watermarks area on left and preview are on the right.
On the left you can add images for watermarking, add different types of watermarks like text, image or previously saved watermarks and start the watermarking process.
On the right you can view the preview of the image on which you are applying the watermark in various sizes including full screen. You can zoom in, zoom out, view the image in full size or scaled to fit the viewing area.
Adding Images to Watermark
There are four ways to select images for watermarking
Add images
Click on the Add Images button or choose Add images option from the File menu. It will present you with a file browse window to choose images to add. You can select multiple images in the file browse window.
Add folder
You can add all images from a folder. Click on the Add folder button or select the Add folder option from the File menu and you will be presented with the following window 

You can select a folder from which you want to add images. You can specify if images of certain type only are to be added and whether to add images from sub folders.
Drag images
You can drag images from Windows Explorer on to uMark program window to add them to watermarking list.
Add from Windows Explorer
You can add uMark to Windows Explorer context menu and you can add images to the list by right clicking on the images and selecting Add Watermark option.
Adding Watermarks

uMark allows adding two types of watermarks – text and image. You can save the watermark settings for future use.
When you click on the Add watermark option you get three options – 
Add Text Watermark 
Add Image watermark 
Add Saved Watermark 
Once you have added the watermarks, you can edit any of the watermarks by double clicking on it. 
Text Watermark
A text watermark allows you to specify any text, special characters or EXIF properties as a watermark.
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Watermark Text
You can write any text in the large textbox provided on the top and you can immediately see the preview under the window. You can drag and move the text watermark settings window anywhere on the screen. 

More Text
You can use various macros as the watermark text. Macros are special placeholders that are converted to appropriate value for each image. You can add macros like image name with or without extension, full image path, date of creation and various EXIF properties found on the photo.

Please note that only those EXIF properties are displayed which are found on the photo.

You can double click on a macro to insert it in the watermark text or select a macro and click on the Insert Selected Macro button.

You can add special characters like © or £ symbols using the Insert special character button. It will open a window with various special characters and you can select any character to add to the watermark text.

Font Options
You can specify various font options like the font name, size, italic, bold, underline and strikethrough. Apart from the default font sizes you can also manually type in a size that is not in the list. You can choose the text color and whether to add a shadow and the color of the shadow as well.

Watermark Options
The transparency option allows you to specify how transparent the watermark should be. Value of zero will make the watermark completely invisible.

You can choose a rotation angle for your watermark. You can select one of the eight predefined angles or specify your own value between 0 and 360. The normal value is zero which is same as 360 which means no rotation. 

Tiling
You can choose to tile your watermark with horizontally or vertically or both. Select the appropriate option to enable tiling. Set the spacing between tiles by entering the value in the respective text boxes. 

Position
You can place the watermark at one of the nine predefined positions or use a custom left and top position. Note that in case tiling is enabled the position values don’t have any effect.

Padding
Depending on the position you can also specify the padding or margin of the watermark from the left, top, right or bottom edges of the image. For instance if you wish to put the watermark on left, top side but want to keep a margin of 100 pixels you can specify 100 in the top and left padding boxes.

Image Watermark

You can add any image or logo as a watermark. Simply select the Add Image Watermark option from Add Watermark button and select the image by clicking on the browse button.
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Watermark Options

The transparency option allows you to specify how transparent the watermark should be. Value of zero will make the watermark completely invisible.

You can choose a rotation angle for your watermark. You can select one of the eight predefined angles or specify your own value between 0 and 360. The normal value is zero which is same as 360 which means no rotation. 

Tiling

You can choose to tile your watermark with horizontally or vertically or both. Select the appropriate option to enable tiling. Set the spacing between tiles by entering the value in the respective text boxes. 

You can place the watermark at one of the nine predefined positions or use a custom left and top position. Note that in case tiling is enabled the position values don’t have any effect.

Padding
Depending on the position you can also specify the padding or margin of the watermark from the left, top, right or bottom edges of the image. For instance if you wish to put the watermark on left, top side but want to keep a margin of 100 pixels you can specify 100 in the top and left padding boxes.
Saved Watermark

uMark allows you to save a watermark for repeated future use. To add a previously saved watermark/s select the Add Saved Watermark option from the Add Watermark button. Following window will appear.
Select any of the previously saved watermarks from the list and click on the Load button. All the watermarks from that setting will be added to the watermarks list. You can also delete any of the previously saved watermarks.

Editing Watermark

Once you have added the watermarks, you can change the settings of any watermark by double clicking on a watermark in the list.

In case you want to change the order in which watermarks are applied to the image you can use the move up, move down arrow buttons. You can remove any or all of the watermarks from the list by clicking on the remove button.
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All the options are also available by right clicking on the watermark list and from the watermark menu on top.
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Preview
The right side of the uMark main program window shows the preview of the watermark on the image which is currently selected in the list.
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There are various sizing options on top of the preview area that let you view the loaded image in actual size, or fits it in the viewing area. You can zoom in or zoom out of the current preview or choose to view the image in full screen mode. The fit Screen option will enlarge the smaller images to fit the viewing area. 
With uMark 3, you actually view each image as it is being watermarked.
You can connect with us on Facebook and join the community of other uMark users by clicking on the little Facebook icon.

We have a watermarking tips and tricks blog at www.watermarkingtips.com where we share useful tips about watermarking and photography in general. You can access the blog by clicking on the RSS icon.

Start Watermarking
Once you have added the images to watermark and have created the watermarks, you can start the watermarking process by clicking the Start Watermarking button.
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Upon clicking the Start watermarking button, Output Options window will appear where you can specify various options for saving the watermarked images.
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Output Location
You can select a folder where watermarked images will be saved.
Note that uMark never overwrites the original images because a watermark once added cannot be removed without damaging the underlying image. So uMark always prompts you to save images in a separate folder.
Output Format 
uMark lets you select the output type of the watermarked images. You can either choose for the same type as the source hence no type conversion will happen or you can specify JPG, BMP, GIF, PNG or TIFF format as output format.
If you are saving the image in the JPG format then you can specify the compression level or the quality of the image. Saving them with 100% will create huge sized images. We recommend saving the images with 80% quality. This won’t have any visible effect on the quality of the image but will save a lot in terms of the image size.
uMark can also rename the output images. By default output images will have same name as the input image, but you can choose to rename them and can also make use of some predefined macros.
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Following renaming macros are available –
[O] – Original filename
[#] – Single digit counter (1,2,3,4….)
[##] – Two digit counter (01,02,03,04….)
[###] – Three digit counter (001,002,003,004….)
[####] – Four digit counter (0001,0002,0003,0004….)
[D] – Current Date (in mmddyyyy format)
[DD] – Current Date (in ddmmyyyy format)
The renaming option takes care of the file extension so you just need to specify the macro and custom text. 
For example a renaming pattern of Sample_[##] will output the files as Sample_01.xxx, Sample_02.xxx, Sample_03.xxx etc.
Resize Watermarked Images 
This option lets you create thumbnails of the output images or resize them as you may wish. There are two primary options available for resizing, proportionate and absolute. Proportionate resizing will resize the images in percentage terms i.e. 50%, 75% etc. Absolute resizing will resize the images as per the pixel values provided by user.
Don’t enlarge Smaller Images
When you check this text box, smaller images will not be enlarged. Say you specify images to be resized to 300X300 pixels and check this box, then all the images bigger than this value will be scaled down but smaller images will not be enlarged.
Preserve Aspect Ratio
If you wish to resize the images in proportion to their height and width then you need to select this option. If you have selected absolute resizing and haven’t checked this option then you must specify both height and width for the resized images. If this option is checked then you need to specify wither height or width for absolute resizing and the other value will be calculated automatically by uMark.
Set as Default 
Use this option to save the chosen settings as default settings. If you set a settings as default, next time when you run uMark those settings will be selected automatically.
Save Watermarks
You can save your frequently used watermark settings so you don’t have to create them again all the time. To save watermarks created right click on the watermarks list and select the Save Watermark option.
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You will be asked to provide a name for the watermark setting. If you have previously saved a watermark by the same name you will be given an option to overwrite the current setting.
Import Watermark Settings
uMark 3 is capable of importing the settings from previous version of uMark. When you run uMark 3 for the first time it will detect if you have a previous version of uMark installed. If a previous version of uMark is found, you will be prompted for permission to import the saved settings from the previous version.

In case uMark is not able to find the previous version or it is not able to ascertain the path of the uMark installation, or if you have saved the uMark settings at some other location you can use the Import watermark settings from older version option to import those settings.
Show uMark in Explorer Context Menu
Selecting this option will add an option to the image files context menu in Windows Explorer. All the BMP, JPG, GIF, PNG and TIFF files will have an option called Add Watermark in their explorer context menu. You can quickly add a watermark to an image by making use of this feature.
Registering uMark
If you have purchased a license key for uMark then you can use it to Register uMark on your computer and convert it from the trial version to a full version.
Just select Enter Registration Key option from the uMark splash screen or select Register option from the Help menu.
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Enter the Name in which you have purchased the license key and the key you have received in the email. Please make sure you enter the name and key exactly as it is mentioned in the email you have received from us. If there are any variations in the name or the key, uMark will not register.
Showing Tips
uMark shows useful tips on startup. You can access them any time using the Show Tips options. You can browse through various tips b clicking on the Next Tip button. You can enable or disable the option of displaying tips when the program starts.
Support
Plenty of help is at hand with uMark.
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Help Manual option will open this help manual.

Videos option will open uMark demonstration videos on our site.
If there’s a problem or you need assistance with a feature you can contact the support by selecting the Contact Support option. It will open the contact us page on our web site from where you can send us a support email.
Show tips option will show the tips window. 
If you want to check for the latest version of uMark you can select the Check Latest Version option. It will check if you are running the most recent version of uMark and if there is a latest version available, it will take you to the download page on our web site. 
You can connect with us on Facebook. 
We have a blog on Watermarking tips and tricks which can be accessed at www.watermarkingtips.com. 
Uconomix on the web - www.uconomix.com 
Contact Support - support@uconomix.com 
Contact Sales - sales@uconomix.com 
